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Abstract 

 
Virtual Worlds have the potential to transform the way people learn, work, and play.  With the emerging fields of 

service science and design science, professors and students at universities are in a unique position to lead the research 

and development of innovative and value-adding virtual worlds. However, a key barrier in the development of virtual 

worlds—especially for business, technical, and non-artistic students—is the ability to model human figures in 3-D for 

use as avatars and automated characters in virtual worlds. There are no articles in either research or teaching journals 

which describe methods that non-artists can use to create 3-D human figures. This paper presents a repeatable and 

flexible method I have taught successfully to both artists and business students, which allows them to quickly model 

human-like figures (manikins) that are sufficient for prototype purposes and that allows students and researchers alike 

to explore the development of new kinds of virtual worlds.  
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Introduction 

* The widespread incorporation of advanced graphics 

processors in cellphones, tablets, and other mobile 

devices—combined with the availability of portable full-

body motion capture controllers such as the Microsoft 

Kinect™—is creating a kind of digital ecosystem in 

which 3-D Virtual Worlds can operate.   

A 3-D virtual world is a computer program that 

displays to users 3-D representations of people, places, 

and other things found in the “real world,” and that allows 

users to flexibly interact with these representations via 

standard input devices like a keyboard and mouse, or 

more sophisticated input devices like accelerometers or 

motion capture controllers. 

                                                           

*Corresponding author. Email: nickflor@unm.edu 

A third-person 3-D virtual world also contains an 

avatar—a character under a user’s control that the user 

can see and that is central to the user’s feeling of 

immersiveness in the virtual world (see Figure 1).  

Avatars do not have to look anything like a user, nor do 

they have to look human, but human-like figures are the 

most common type of avatars in virtual worlds. 
 

 
 

Figure 1. Virtual UNM Campus Developed by the 
Author on a Mobile Device, Avatar in the Center 
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Similar to when the web first emerged as a technology, 

the most innovative uses of virtual worlds lie waiting to 

be discovered.  If university researchers and students are 

to lead the discovery of innovations in virtual worlds it is 

necessary for them to have the ability to build and 

experiment with different kinds of virtual worlds, rather 

than work under the constraints of existing commercial 

virtual worlds.  A key barrier to building virtual worlds is 

modeling avatars. 

 

 

LITERATURE REVIEW ON 3-D HUMAN 
FIGURE MODELING 

The value of virtual worlds as educational tools has 

been noted prior to the turn of the century (Dede, 1996).  

Researchers are starting to explore the potential of virtual 

worlds as tools for studying social behaviors scientifically 

(Bainbridge, 2007), for education (Vincenti & Braman, 

2010) for business-related purposes (Hemp, 2006).  How 

to build virtual worlds has not been a primary topic of 

research.   

Most of the research on business uses of virtual worlds 

has focused on analyzing how companies use existing, 

commercially available virtual worlds, such as Second 

Life or World of Warcraft.  Missing in the academic 

literature is research on how to actually build new kinds 

of virtual worlds, as this is viewed as practice not 

research.  Instead, such knowledge is distributed 

throughout trade books written by either art professors 

(Ratner, 2009) or by practitioners (Patnode, 2008). 

However, research on how to build new systems is 

important too.  The emerging fields of Design Science 

(Hevner, March, Park, & Ram, 2004) and Service Science 

(Maglio & Spohrer, 2008), argue that as a science of the 

artificial (Simon, 1996) it is just as important for 

researchers to create new, value-adding artifacts as it is to 

study existing ones.   

The technology for building virtual worlds has 

advanced to the point where a single individual unaided 

can build one (Flor, 2011).  A key enabling skill for 

implementing virtual worlds is modeling human figures.  

Although the aforementioned trade books all discuss 

methods for modeling human figures, these books are 

written for art students and most of the techniques are not 

repeatable by non-artists and are more suited for games 

and movies than virtual worlds. 

The method presented below is one that non-artists can 

follow to prototype a human figure (a “manikin”) and that 

can be easily modified to create different types of avatars.  

It qualifies as design-science research under the seven 

guidelines of design science (Hevner, March, Park, & 

Ram, 2004, p. 82).  In particular the method: (1) is a 

useful and novel artifact; (2) has a specific problem 

domain—virtual worlds; (3) has been tested on non-

artists; (4) allows non-artists to perform a difficult task, 

namely modeling 3-D human figures; (5) is defined 

rigorously so that non-artists can duplicate the steps 

needed to create a 3-D figure; (6) was developed after 

analyzing the difficulties in the space of existing 

modeling methods.  The seventh guideline is to 

communicate the results effectively to technical and 

managerial audiences, which is the goal of this paper. 

Before discussing the method in this paper for 

modeling 3-D human figures, we will first review how 

professional modelers in the movie and gaming industries 

typically model characters. 

 

 

3-D Tracing 
 

The method most commonly used in industry to model 

human figures is commonly referred to as character 

modeling with reference pictures, although I use the term 

“3-D tracing” because it is analogous to the technique of 

placing see-through paper over a photograph and creating 

a drawing by tracing.  The method can be seen in a variety 

of books including, Guindon (2007, pp. 15-83), Ingrassia 

(2009, pp. 269-288), Oliverio (2007, pp. 47-323), Patnode 

(2008, pp. 133-207), and Russo, (2006, pp. 83-152).  The 

major steps are as follows (see Figure 2 for depictions of 

the steps): 

 

1. The modeler first obtains reference pictures.  In 

the movie and videogaming industries, these reference 

pictures are typically drawn by a concept artist in the art 

department.  However, if the 3-D model is intended to 

represent an actual person, then reference photographs of 

the actual person are used instead of drawings.  The 

reference pictures depict front and side views of the 

character to be modeled, with features lined up in both 

photos including the top of the head, the waistline, and the 

bottom of the feet. 

 

2. The reference pictures are then imported into a 

modeling program.  The pictures are placed at right angles 

to one another, and centered. 

 

3. The modeler adds a simple box to the workspace 

so that it overlaps the torso in both the front and the side 

reference-picture views. 

 

4. Finally, the modeler molds the box to the 

reference drawings—extruding limbs, adding edge loops, 

and moving vertices so that the edges of the model line up 

with the edges in the reference pictures. 
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1. Obtain Reference 

Pictures 

2. Import Reference 

Pictures

into the Modeling program

3. Add a Box that Covers  

the Torso in Front and  

Side Views.   

4. Add Edges, Extrude 

Limbs;

Move Vertices over 

Pictures

(ref. pics not

clarity

 

Figure 2. 3-D Tracing:  A Modeler (1) Takes front 
and side pictures of a human figure; (2) Imports 

them into a 3-D modeling program; (3) Adds a basic 
box that covers the torso; (4) Mold the box to the 

pictures. 
 

3-D tracing is by far the most common technique for 

modeling human figures.  Yet another more advanced 

method for figure modeling is digital sculpting (de la Flor 

& Mongeon, 2010; Spencer, 2010), where the modeler 

creates an entire character without reference pictures.  

However, digital sculpting requires detailed knowledge of 

body proportions and surface anatomy. 

 

 
 

Comparison of 3-D Tracing with my 
Manikin Modeling Method 

Methods for modeling human figures in 3

not new.  Moreover, there are an abundance of tuto

on the “3-D tracing” method written by both professional 

modelers and by modeling enthusiasts, in trade books and 

in social-media video websites like YouTube.

There are three main problems with 3-

method for non-artists.  First, it requ

pictures.  If the modeler is not an artist, then development 

is hindered while the modeler either works with an artist, 

or finds pictures, or takes photographs.  Taking 

photographs can be non-trivial, as reference pictures may 

require actors, costumes, and props to be built.  Second, it 

is time consuming to model using 3-D tracing as the 

modeler must constantly move vertices and edges to line 

them up with the reference pictures in both front and side 
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2. Import Reference 

Pictures 

into the Modeling program 

4. Add Edges, Extrude 

Limbs; 

Move Vertices over 

Pictures 

s not shown for 

clarity) 

D Tracing:  A Modeler (1) Takes front 
and side pictures of a human figure; (2) Imports 

D modeling program; (3) Adds a basic 
box that covers the torso; (4) Mold the box to the 

the most common technique for 

modeling human figures.  Yet another more advanced 

method for figure modeling is digital sculpting (de la Flor 

& Mongeon, 2010; Spencer, 2010), where the modeler 

creates an entire character without reference pictures.  

, digital sculpting requires detailed knowledge of 

D Tracing with my 

Methods for modeling human figures in 3-D are certainly 

not new.  Moreover, there are an abundance of tutorials 

D tracing” method written by both professional 

modelers and by modeling enthusiasts, in trade books and 

media video websites like YouTube. 

-D tracing as a 

artists.  First, it requires reference 

pictures.  If the modeler is not an artist, then development 

is hindered while the modeler either works with an artist, 

or finds pictures, or takes photographs.  Taking 

trivial, as reference pictures may 

, costumes, and props to be built.  Second, it 

D tracing as the 

modeler must constantly move vertices and edges to line 

them up with the reference pictures in both front and side 

views.  In fact, one professional video ga

reported taking on average one to three weeks to complete 

a figure (Olson, 2009), although it should be noted that 

these were detailed figures.  Third, detailed human figures 

created via 3-D tracing are unnecessary for prototyping 

useful virtual worlds, which is the main goal of virtual 

world experimenters. 

The manikin method has the following benefits versus the 

3-D tracing method.  First, it is easy to teach to non

artists.  I have taught the method in a 1.5 hour lecture to 

business students, none of which were artists.  Second, the 

method is easy to learn and its application produces 

repeatable results.  Over ninety percent of business 

students who were taught the method, successfully 

modeled a 3-D manikin in under a week.  Third, the 

method is flexible and extendable as different kinds of 

manikins can be created, and detailed can be added to 

these manikins at a later time if needed, using a variation 

of the 3-D tracing method.  Finally, the method creates 

human figures that are good enough for 

purposes.  In my courses, the usefulness of the virtual 

worlds that the students create takes precedence over 

aesthetics.  By not having to spend so much time on 

modeling characters, students can focus on functionality 

and add aesthetics to their manikins at a later time.  This 

is similar to the approach taken in figure drawing, where 

artists first draw a posed human figure using cylinders, 

cubes, spheres and other basic geometric primitives 

(Loomis, 1943).  This allows the artist to focus on bo

the action depicted and the meaning of the action

like muscles, clothing, and shadow are added later.

In the following sections, we examine the manikin 

method and the test of the method on both artistic and 

non-artistic students. 

A REPEATABLE 
METHOD FOR MODELING HUMAN 
FIGURES IN 3-D: THE MANIKIN METHOD
 

     3-D modeling is an activity where an individual creates 

representations of real or imagined things

have width, height, and depth

computer program known as modeling software.  The 

representations that one creates using modeling software 

are called models, and the person that creates them is a 

modeler 

Choosing Modeling Software
Available Packages 

Popular commercial modeling software packages include 

Maya and 3ds-Max, both by Autodesk Corporation, while 

the most popular open-source modeling software package 

is Blender.  Both Maya and 3ds Max are expensive 

software packages, as they are used to creat

both Hollywood movies and videogames.  However, 
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views.  In fact, one professional video game modeler 

reported taking on average one to three weeks to complete 

a figure (Olson, 2009), although it should be noted that 

these were detailed figures.  Third, detailed human figures 

D tracing are unnecessary for prototyping 

worlds, which is the main goal of virtual 

The manikin method has the following benefits versus the 

D tracing method.  First, it is easy to teach to non-

artists.  I have taught the method in a 1.5 hour lecture to 

one of which were artists.  Second, the 

method is easy to learn and its application produces 

repeatable results.  Over ninety percent of business 

students who were taught the method, successfully 

D manikin in under a week.  Third, the 

flexible and extendable as different kinds of 

manikins can be created, and detailed can be added to 

these manikins at a later time if needed, using a variation 

D tracing method.  Finally, the method creates 

human figures that are good enough for prototyping 

purposes.  In my courses, the usefulness of the virtual 

worlds that the students create takes precedence over 

aesthetics.  By not having to spend so much time on 

modeling characters, students can focus on functionality 

ir manikins at a later time.  This 

is similar to the approach taken in figure drawing, where 

artists first draw a posed human figure using cylinders, 

cubes, spheres and other basic geometric primitives 

(Loomis, 1943).  This allows the artist to focus on both 

the action depicted and the meaning of the action—details 

like muscles, clothing, and shadow are added later. 

In the following sections, we examine the manikin 

method and the test of the method on both artistic and 

A REPEATABLE AND FLEXIBLE 
METHOD FOR MODELING HUMAN 

D: THE MANIKIN METHOD     

D modeling is an activity where an individual creates 

representations of real or imagined things—that appear to 

have width, height, and depth—using a special kind of 

uter program known as modeling software.  The 

representations that one creates using modeling software 

are called models, and the person that creates them is a 

Choosing Modeling Software—Freely-
 

Popular commercial modeling software packages include 

Max, both by Autodesk Corporation, while 

source modeling software package 

is Blender.  Both Maya and 3ds Max are expensive 

software packages, as they are used to create models for 

both Hollywood movies and videogames.  However, 
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Autodesk makes them available freely, with full 

functionality; the only restriction is that anything created 

by the software is for academic-use only.  Instructors and 

students can download these packages from 

students.autodesk.com, after registering with an e

address from a recognized academic institution.  Blender 

can be downloaded from www.blender.org.  

Most all 3-D modeling software packages are sufficient 

for modeling human figures using the manikin method.  

The decision of what package to use in a course will 

depend largely on the computers available to the 

instructor and to the students—as not all modeling 

software will run on all operating systems.  In particular, 

both Maya and Blender run on the Windows, the Mac, 

and the Linux operating systems.  3ds Max runs only on 

the Windows operating system.  At the University of New 

Mexico’s Interdisciplinary Film & Digital Media 

program, Maya is the preferred package since the students 

own both Macs and PCs, and it is the modeling software 

most commonly used by the movie industry, which is a 

target employer for the students.  

Polygon Modeling 

There are two basic ways to model, using polygons or 

using curves.  This paper covers polygon modeling

most popular kind of modeling for virtual worlds.  The 

person that creates the 3-D models is known as a modeler.  

Using polygon modeling, the modeler starts with a basic 

object — e.g., a cube, sphere, or pyramid with a certain 

width x height x depth and with a certain number of faces 

— much like a sculptor starts with a lump of clay.  The 

modeler then molds this source object into a target object 

using the operations of moving, cutting, extruding, 

wedging, merging, deleting, and mirroring, which are 

applied to the object’s vertices, edges, and faces.  

The following describes the general lecture script that I 

developed for teaching students how to model a 3

manikin.  I have intentionally written the lecture script in 

general terms—without reference to any software

operation—so that an instructor can adapt it easily to the 

specific modeling software that he or she uses.  The script 

assumes the instructor and students have working 

knowledge of the basic modeling operations, which are 

listed in italics in the script.  For those unfamiliar with 

basic modeling operations, Appendix A provides a 

tutorial of these operations specific to the Maya software 

package. 

Part 1. Creating the Body 

To create a body: (1) Create a cube that is 1x2.5x1 units 

with 2x5x2 faces; (2) Wedge the top back face 45 

degrees, yielding an arm face; (3) Move the outer

bottommost edges +.1 units in the x direction yielding a 
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modeler then molds this source object into a target object 
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developed for teaching students how to model a 3-D 
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knowledge of the basic modeling operations, which are 
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basic modeling operations, Appendix A provides a 
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To create a body: (1) Create a cube that is 1x2.5x1 units 

2x5x2 faces; (2) Wedge the top back face 45 

degrees, yielding an arm face; (3) Move the outer-

bottommost edges +.1 units in the x direction yielding a 

leg face; (4) Extrude the arm face 2.5 units, inset by .1 

units; (5) Extrude the leg-face 2 units yieldin

Move the thigh face’s inner-bottommost edge +.1 units in 

the x-direction; (7) Extrude the thigh face 2 units, inset by 

.1 units, yielding a calf; (8) Move the middle back 

vertices to a z-value of zero and merge the overlapping 

vertices, yielding a back wedge; (9) Mirror to see what the 

completed body will look like; (10) Save file as “body”.

   

1 2-3 4 5

Figure 3. Modeling the Body (see text for 
explanation)

 

Part 2. Creating the Hand

To create a hand: (1) Create a cube 

faces; (2) Wedge the thumb face 30 degrees; (3) Inset the 

stubs .1; (4) Extrude the fingers .5 with 3 divisions; (5) 

Extrude the thumb .25, then extrude again by .125; (6) 

Move back the pointer and ring finger 

the pinky back -0.125; (7) Move the pinky joint edges 

back -.0625 and move the middle finger joint edges up 

+.0625; (8) Remove the back edges and vertices; (9) 

Move the wrist edges inwards by +.1; (10) Save file as 

“hand”. 

 

1 2 

6 7 

Figure 4. Modeling the Hand (see text for 
explanation) 

 

Part 3. Creating the Feet
 
To create a foot: (1) Create a cube that is .5x.25x1, with 

1x2x2 faces; (2) Merge the toe vertices down; (3) Move 

the ankle sides in by -.1, and move the front ankle edge 

loop back by -.2; (4) Move the toes forward by +1.25; (5) 

Save file as “foot”. 
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leg face; (4) Extrude the arm face 2.5 units, inset by .1 

face 2 units yielding a thigh; (6) 

bottommost edge +.1 units in 

direction; (7) Extrude the thigh face 2 units, inset by 

.1 units, yielding a calf; (8) Move the middle back 

value of zero and merge the overlapping 

ding a back wedge; (9) Mirror to see what the 

completed body will look like; (10) Save file as “body”. 

   

5-7 8 9 

 
Modeling the Body (see text for 

explanation) 

Part 2. Creating the Hand 

To create a hand: (1) Create a cube .5x.125x.5 with 2x1x4 

faces; (2) Wedge the thumb face 30 degrees; (3) Inset the 

stubs .1; (4) Extrude the fingers .5 with 3 divisions; (5) 

Extrude the thumb .25, then extrude again by .125; (6) 

Move back the pointer and ring finger -.0625 and move 

0.125; (7) Move the pinky joint edges 

.0625 and move the middle finger joint edges up 

+.0625; (8) Remove the back edges and vertices; (9) 

Move the wrist edges inwards by +.1; (10) Save file as 

3 4-5 

8 9 

 
Modeling the Hand (see text for 

explanation)  

Part 3. Creating the Feet 

To create a foot: (1) Create a cube that is .5x.25x1, with 

1x2x2 faces; (2) Merge the toe vertices down; (3) Move 

.1, and move the front ankle edge 

.2; (4) Move the toes forward by +1.25; (5) 
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1 2 3 

 
Figure 5. Modeling the Foot (see text for 

explanation)  
 

Part 4. Creating the Head 

To create a head, simply create a cube that is .7x1x1 with 

2x3x3 faces, then save the file as “head”.  The head can 

be shaped after it is attached to the body in part 5.

 

 

Figure 6. Modeling the Head (see text for 
explanation) 

 

Part 5. Combining the Pieces 

The final step is to merge all the pieces into one.  After 

saving all the separate body parts: (1) Import the half

body; (2) Import the foot; (3) Snap foot to leg; (4) Merge 

objects & vertices; (5) Import hand; (6) Snap hand to 

upper limb; (7) Merge objects and vertices; (8) Mirror to 

get the right side of the body; (9) Attach the head; (10) 

Smooth the avatar if desired; (11) Save manikin.

 

1-7 8 9 10 (reverse 

view)

 
Figure 7. Attaching the Body Parts (see text for 

explanation)  
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4 

Modeling the Foot (see text for 

To create a head, simply create a cube that is .7x1x1 with 

then save the file as “head”.  The head can 

be shaped after it is attached to the body in part 5. 

Modeling the Head (see text for 

 

The final step is to merge all the pieces into one.  After 

the separate body parts: (1) Import the half-

body; (2) Import the foot; (3) Snap foot to leg; (4) Merge 

objects & vertices; (5) Import hand; (6) Snap hand to 

upper limb; (7) Merge objects and vertices; (8) Mirror to 

ch the head; (10) 

Smooth the avatar if desired; (11) Save manikin. 

 

(reverse 

view) 

Further 

Shaped 

& 

Textur

ed 

Attaching the Body Parts (see text for 

MANIKIN METHOD TEST
 

Participants 

Sixty-seven students participated in this study.  The 

students came from two different courses offered in the 

Fall of 2010: (1) MGMT 330

Business Programming; and (2) IFDM 205

Digital Space.  There were 43 students in MGMT330, 

none of which had any experience with figure drawing or 

3-D modeling prior to taking the course, which was a 

required course for junior and senior level students 

majoring in management of information systems.  IFDM 

205 is a required course in the University’s 

Interdisciplinary Film & Digital Media program for 

sophomore students.  IFDM is a highly selective program 

where students are admitted based on their combined 

artistic and technical expertise.  There were 24 students in 

IFDM 205, all of them had been introduced to b

modeling in a prior course where they modeled a chair.  

Four of the IFDM students had taken a prior 3

modeling course either at the University or at a 

community college, and one of the four had extensive 

modeling experience but was self

 

Apparatus 
 
For hardware, students used their personal laptops or 

desktop computers to run the 3

The software used was Maya 2010, which the students 

downloaded for free from the Autodesk.com website 

(students.autodesk.com) as part of 

software program for students and faculty.  The IFDM 

computer lab also had Maya 2010 loaded on 22 personal 

computers in case students were unable to load Maya onto 

their personal computers.  However, all 67 students 

reported successfully loading Maya onto their personal 

computers.  The University’s online instructional system, 

WebCT, held a link to YouTube tutorial videos made by 

the instructor on the topic of modeling 3

this video was made available to all students.

 

Procedure 
 
Students were given a lecture on how to model 3

figures based on the lecture script described previously.  

Instead of the term “manikin”, I used the term “robot”, 

which students are more familiar with.  They were then 

given an assignment where they 

a personalized robot avatar and to animate a walk cycle 

for the robot avatar (see Figure 8 for the written 

instructions). 
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MANIKIN METHOD TEST 

participated in this study.  The 

students came from two different courses offered in the 

Fall of 2010: (1) MGMT 330—Fundamentals of Virtual 

Business Programming; and (2) IFDM 205—Activating 

Digital Space.  There were 43 students in MGMT330, 

had any experience with figure drawing or 

D modeling prior to taking the course, which was a 

required course for junior and senior level students 

majoring in management of information systems.  IFDM 

205 is a required course in the University’s 

plinary Film & Digital Media program for 

sophomore students.  IFDM is a highly selective program 

where students are admitted based on their combined 

artistic and technical expertise.  There were 24 students in 

IFDM 205, all of them had been introduced to basic 3-D 

modeling in a prior course where they modeled a chair.  

Four of the IFDM students had taken a prior 3-D 

modeling course either at the University or at a 

community college, and one of the four had extensive 

ut was self-taught. 

For hardware, students used their personal laptops or 

desktop computers to run the 3-D modeling software.  

The software used was Maya 2010, which the students 

downloaded for free from the Autodesk.com website 

(students.autodesk.com) as part of Autodesk’s free 

software program for students and faculty.  The IFDM 

computer lab also had Maya 2010 loaded on 22 personal 

computers in case students were unable to load Maya onto 

their personal computers.  However, all 67 students 

ading Maya onto their personal 

computers.  The University’s online instructional system, 

WebCT, held a link to YouTube tutorial videos made by 

the instructor on the topic of modeling 3-D characters and 

this video was made available to all students. 

Students were given a lecture on how to model 3-D 

figures based on the lecture script described previously.  

Instead of the term “manikin”, I used the term “robot”, 

which students are more familiar with.  They were then 

given an assignment where they had a week both to create 

a personalized robot avatar and to animate a walk cycle 

for the robot avatar (see Figure 8 for the written 
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Based on Professor Flor's Robot as taught in class:

 

1. Model a robot body in Maya (filename: body.mb).

2. Model a robot head in Maya (filename: head.mb).

3. Model a robot hand in Maya (filename: hand.mb).

4. Model a robot foot in Maya (filename: foot.mb).

5. Personalize your robot body parts. 

6. Merge all the body parts to yield a robot avatar.

7. Animate a walk cycle for your robot avatar (filename: 

robot.mb). 

8. Export your walking robot avatar as an fbx file 

(filename: robot.fbx). 

 
Figure 8. Attaching the Body Parts (see text for 

explanation)  

There were two instructional conditions based on the 

course.  In condition 1, students received the lecture 

through YouTube videos that were embedded in the 

University’s online instructional delivery system, WebCT.  

The total time for the video lectures was approximately 

one hour.  All the students in MGMT330 were in 

condition 1, as MGMT 330 was a purely online course 

with no face-to-face component.  In condition 2, students 

were given a one hour face-to-face lecture on modeling a 

humanoid figure in 3-D, and also provided access to the 

video lectures on WebCT for reference purposes.  All the 

students in IFDM 205 were in condition 2.  

 

Results 

There were 24 students in IFDM 205, 22 turned in a 

robot, and 2 did not turn in a robot.  Of the 2 that did not 

turn in a robot, 1 did not turn in any assignments at all.  

Of the 22 that turned in a robot, one person saved the file 

incorrectly and turned in an animated skeleton without the 

robot—however, upon inspection, the student did have the 

robot modeled.  If the person that did not turn in any 

assignments is removed from the total number of students, 

22/23 or 95.6% of the students successfully turned in a 

robot. 

 

 

Figure 9. Robot Manikins Created by the 
Interdisciplinary Film & Digital Media

Students 
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Based on Professor Flor's Robot as taught in class: 

1. Model a robot body in Maya (filename: body.mb). 

2. Model a robot head in Maya (filename: head.mb). 

3. Model a robot hand in Maya (filename: hand.mb). 

4. Model a robot foot in Maya (filename: foot.mb). 

6. Merge all the body parts to yield a robot avatar. 

walk cycle for your robot avatar (filename: 

8. Export your walking robot avatar as an fbx file 
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Robot Manikins Created by the 
Interdisciplinary Film & Digital Media (IFDM 205) 

Students made the following customizations.  For the 

head, students added horns (1

hair (2-11).  For the arms and legs, students added limb & 

muscle tapering (1-5, 1-10,  2

3).  No hands were customized to any visually apparent 

degree.  However, but two student substituted a feet with 

toes (2-6, 2-11) for the standard manikin feet.   For the 

torso, students tapered the waist (1

added wings (2-5), sculpted female 

made chest depressions (1-10); and added shoulder and 

waist props (2-10).  Finally, two students used the 

automatic smoothing function in Maya to create a more 

rounded manikin (2-6, 2-11), and one student added 

clothes (2-11).   Note: Manikins 1

1-8—although highly customized

manikin procedure.  These manikins were created by 

students who came up with their own procedures (1

2, 1-4), or were created in another modeling class (1

2-8)—a fact that was only discovered several weeks after 

the assignment was due. 

There were 43 students in MGMT330.  Of these 43 

students, 33 turned in a manikin, while 10 students did not 

turn in a manikin.  Of the 10 students that did not turn in a 

manikin, 7 did not turn in any assignments at all during 

the semester.  Of the 33 students that turned in a manikin, 

3 did not save their files properly and only turned in an 

animated skeleton.  However, when their work was 

checked in person, they indeed modeled a maniki

correctly.  If you removed, the 7 students that did not 

show up to class, then 91.6% of the students successfully 

followed the procedure for modeling a manikin.

 

   

   

   

   

Figure 10. Robot Manikins
Management (MGMT 330) Students

MGMT 330 students made the following customizations.  

For the head, students added hair (1

(4-5), and one substituted a pumpkin (3

head from the procedure.  For the ar
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Students made the following customizations.  For the 

head, students added horns (1-6), hats (2-9, 2-10), and 

11).  For the arms and legs, students added limb & 

10,  2-6, 2-7, 2-11) and props (2-

hands were customized to any visually apparent 

degree.  However, but two student substituted a feet with 

11) for the standard manikin feet.   For the 

torso, students tapered the waist (1-5, 1-10,  2-6, 2-7), 

5), sculpted female chests (2-6, 2-7), 

10); and added shoulder and 

10).  Finally, two students used the 

automatic smoothing function in Maya to create a more 

11), and one student added 

nikins 1-1, 1-2, 1-4, 1-11, and 

although highly customized—did not follow the 

manikin procedure.  These manikins were created by 

students who came up with their own procedures (1-1, 1-

4), or were created in another modeling class (1-11, 

t that was only discovered several weeks after 

There were 43 students in MGMT330.  Of these 43 

students, 33 turned in a manikin, while 10 students did not 

turn in a manikin.  Of the 10 students that did not turn in a 

not turn in any assignments at all during 

the semester.  Of the 33 students that turned in a manikin, 

3 did not save their files properly and only turned in an 

animated skeleton.  However, when their work was 

checked in person, they indeed modeled a manikin 

correctly.  If you removed, the 7 students that did not 

show up to class, then 91.6% of the students successfully 

followed the procedure for modeling a manikin. 

     

     

     

     

 
Robot Manikins Created by the 

Management (MGMT 330) Students 

MGMT 330 students made the following customizations.  

For the head, students added hair (1-3), a hat (2-1), horns 

5), and one substituted a pumpkin (3-5) for the manikin 

head from the procedure.  For the arms and legs, one 
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student added arm tapering (row 1-col 8), another student 

added multiple arms (4-5).   No hands were customized to 

any visually apparent degree.  However, one student 

substituted feet with heels (1-3) and another substituted 

flatter feet for the standard manikin feet.   There was only 

one torso customization, where a student sculpted a 

female chest (1-3).  Finally, three students used the 

automatic smoothing function in Maya to create a more 

rounded manikin (1-4, 3-2, and 3-5), and one student used 

the coloring features of Maya to create a green and orange 

manikin (3-5). 

 
SUMMARY AND CONCLUSION 
 
The ability to model human figures is a difficult skill for 

non-artists to acquire, using current methods like 3-D 

tracing or digital sculpting.  The reason for the difficulty 

is that these methods are aimed at creating highly-detailed 

figures for movies and games and require either in-depth 

artistic knowledge or anatomical knowledge.  Without 

this knowledge, one must collaborate with others that 

possess it.  

The inability to model human figures in 3-D is one key 

deterrent for non-artists that would like to experiment 

with new forms of virtual worlds.  This paper presented a 

flexible and repeatable method that non-artists can master 

in a short amount of time, to quickly develop 3-D human 

figures that are suitable for virtual world prototyping.  

While these figures—manikins—are not as detailed as 

those created by 3-D tracing or digital sculpting, they do 

not have to be for the purpose of experimenting with 

virtual worlds.  However, the method is flexible enough 

that once one settles on a virtual world design, the details 

can be added later using either 3-D tracing or digital 

sculpting. 

I presented a test of the method on two classes of 

students—both artists (film & digital media students) and 

non-artists (management students)—with over 90% of the 

students in both classes able to successfully model a 3-D 

figure in under a week.  While this is a good result and 

shows the repeatability of the method, the amount of 

customization in the student manikins was minimal.  

Since the manikins of the artistic students also lacked 

extensive customizations, I attribute the minimal 

customizations to a lack of emphasis in the assignment 

instructions.   

One drawback of the manikins is that they are not detailed 

and do not look realistic.  It is possible to layer detail and 

realism on the manikins (see Figure 7, last panel), but this 

is currently a tedious process that combines 3-D tracing 

with texture mapping, the latter of which can be thought 

of as a process of painting the body of the manikin.  Yet 

detail and realism is desirable when moving from a virtual 

world prototype to a commercial virtual world product.   

Future research is needed to develop methods, similar to 

the manikin method, that allows non-artists to quickly 

transform manikins into more realistic-looking human 

figures.  For those realistic figures that are not based on 

actual people, this will require discovering how to teach a 

streamlined form of human anatomy.  For figures based 

on actual people, an alternative to importing pictures and 

tracing must be discovered.  I believe a method similar to 

drawing caricatures might suffice, where prominent 

features in a person are emphasized but not duplicated.  

In closing, the most innovative and useful forms of virtual 

worlds have yet to be discovered.  The manikin method, 

combined with knowledge of programming, animation, 

and terrain modeling, gives non-artists the ability to 

experiment with developing new forms of virtual worlds.  

This research is a step towards helping researchers, 

students, and entrepreneurs explore the space of possible 

virtual worlds. 
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APPENDIX A: TUTORIAL—BASIC 
POLYGON MODELING OPERATIONS IN 
MAYA 

The following tutorial describes the basic polygon-

modeling operations used by the Manikin Method to 

model a character in Maya, which can be obtained freely 

at students.autodesk.com for non-commercial, academic 

use only.  While Maya is just one of many 3-D modeling 

software packages available, almost all modeling software 

supports the operations that will be described—the 

differences lie in the user-interfaces.  If you are unfamiliar 

with 3-D modeling, you should first familiarize yourself 

with these basic operations before attempting the Manikin 

Method. 

 

Enter Polygon Modeling Mode <F3> 

The following operations assume you are in Maya’s 

polygon-modeling mode.  If you are not in this mode, the 

proper menus will not be displayed.  The shortcut for 

entering polygon mode is the <F3> key.  There is also a 

drop-down box in the upper-right corner of the program, 

but this drop-down is not always displayed unless you 

select the menu item Display > UI Elements > Show All 

UI Elements. 

Create Box Operation 

In polygon modeling, you use boxes with various 

dimensions and divisions as the starting point for different 

body parts.  Suppose you wanted to create a box that 

represents the torso of a human figure.  Further, assume 

you want the box to have a width x height x depth of 1 x 

2.5 x 1, and to have edge-loop divisions of 2 x 5 x 2.   

The steps to create this box are as follows (refer to Error! 

Reference source not found., italicized text refers to 

labels in the Maya user interface.  Unless otherwise 

stated, a click or select action refers to a left-mouse 

click.): 
 

 

1 

 

 
 
 
 
 
 
 
 
 
 

Figure 11. Robot Manikins Created by the 
Management (MGMT 330) Students 

1.  Select the menu item: Create > Polygon Primitives >    

     Cube > Options (options are selected by clicking the  

     square next to the label).  

a.  Note: Ensure that the Interactive Creation box is  

     unchecked. 

b.  Response: The Polygon Cube Options window opens. 

2.  Enter 1, 2.5, and 1 in the Width, Height, and Depth  

     textboxes.  Enter 2, 5, 2 in the Width divisions, Height  

     divisions, and Depth divisions textboxes, then click the  

     Create  button. 

a.   Response: A box is created in the workspace. 

3.   (A box is displayed with dimensions 1x2.5x1, and  

      2x5x2 edge loop divisions). 

 

Wedge Operation 
 
Wedges are useful for creating body parts that are angled. 

Examples include the base of the thumb relative to the 

palm of the hand, and the shoulder relative to the torso.  

The following shows how to create a 45 degree wedge 

that represents a shoulder on a torso (refer to Figure 12): 

  

1 2 

 

 

2 

 

3 
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3 4 

Figure 12. Wedge operation 
 
1.  Right-click anywhere over the object and select Multi.  

a.  Explanation: This is a selection mode that allows you  

     to choose groups of faces, edges, or vertices. 

b.  Response: None visible.  You are in the Multi selection  

     mode. 

2.  Click on the face that is furthest back, on the top-right- 

     side of the cube.  Shift-click on the bottom edge of this  

     face.   

a.  Explanation: The wedge operation requires both a face  

     and an edge, where the edge is like a hinge that the  

     face swings around to create the wedge. 

b.  Response: The select face and the edge are highlighted. 

3.  Select the menu item: Edit Mesh > Wedge Face >  

     Options 

a.  Response: The Wedge Face Options window opens. 

4.  Enter 45 and 1 into the Arc angle: and Divisions:  

     textboxes, respectively.  Then click the Wedge Face   

     button.   

a . Explanation: The 45 is the wedge’s sweep angle in  

     degrees, and the 1 determines how many slices are in   

     the wedge. 

b.  Response: A wedge of 45 degrees. 

 

Extrude Operation & A Note on the Inset 
Operation 
 

The extrude operation is useful for modeling limbs, 

fingers, and other protrusion on the human body.  The 

following example uses the extrude operation to create an 

arm (refer to Figure 13): 

1.  Click on the shoulder face. 

a.  Note: You should be in face-selection mode, via the  

     menu item Select > Face 

b.  Response: The shoulder face is highlighted. 

2.  Select the menu item Edit Mesh > Extrude > Options 

a.  Response: The Extrude Face Options window opens. 

3.  Enter 2 into the Divisions: textbox, and enter .1 into  

     the Offset: textbox, then click the Extrude button. 

a.  Note:  Leave all other values at their defaults. 

b.  Explanation:  When you extrude, the default is a single  

     extrusion.  Entering 2 divides the extrusion into two  

     pieces, representing the upper and lower arms.  The  

     offset controls the size of the extrusion’s ending  

     stump.  The .1 moves all edges on the stump inwards  

     by .1 units.  This will ultimately lead to a skinny wrist  

     relative to the upper and lower arms. 

c.  Response : Control arrows for pulling out the extrusion    

     on the shoulder face. 

4.  (Extrusion control arrows displayed over the face) 

a.  Note:  At this point, you could pull the arrow that is  

     normal to the face in order to create an arm.   

     However, according to artistic canons of proportion,  

     the arm must be a specific length, namely 2.5 units.         

     The next step allows you enter a specific length for an  

     extrusion. 

5.  Select the menu item: Display > UI Elements >  

     Attribute Editor. 

a.  Response: The Attribute Editor pane appears on the  

     right side of the workspace. 

6.  Type 2.5 into the Local Translate Z textbox then press  

     <Enter>.  The Z textbox is the third textbox to the right  

     of the label, and always corresponds to the control  

     arrow that is normal to the face. 

a.  Response:  An extrusion representing an upper arm,  

     lower arm, and wrist 

 

 

1 

 

2 

 

3 

 

4 
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5 

 
6 

Figure 13. Extrude operation 

 

 

A Brief Note on the Inset Operation 
 
A face within a face is known as an “inset”.  You create 

an inset by doing the extrude operation with an offset 

(Figure 13, steps 1-4), but not pulling out an extrusion 

(viz., not doings steps 5-6 in Figure 13).  Figure 14 

depicts a close-up of the inset created by Steps 1-4. 

 

 
 

Figure 14. A Close-Up of an Inset 
 

 
Moving Elements—Relative Movement & a 
Note on Absolute Movement 

To move a vertex, an edge, or a face of an object 

freehand, you: (a) enter either vertex mode , edge mode, 

or face mode, via the menu items Select > Vertex, Select 

> Edge, or Select > Face; (b) select a vertex, edge, or face; 

(c) select the move icon in the toolbox bar; (c) click and 

drag the vertex, edge, or face.  However, moving elements 

freehand is not precise.  The following demonstrates how 

to move vertices in a relative direction, by a specific 

amount, +0.1 in the X-direction, to prepare a face for a leg 

extrusion. 

  

1 2 

  

3 4 

Figure 15. Move Relative operation 

 

1.  If the user-interface Status Line is not displayed,  

     display it by selecting the menu item Display > UI  

     Elements > Shelf. 

a.  Explanation: The Status Line is a toolbar that contains  

     3 textboxes known as the “Input Line”, which allows  

     you to type in X-Y-Z values for vertices. 

b.  Response: The Status Line toolbar appears 

2.  Select a vertex or shift-select multiple vertices, which  

     are to be moved. 

a.  Note: I selected the lowermost three vertices on the  

     right side of the torso. 

b.  Response: The selected vertices are highlighted. 

3.  Select Relative transform in the drop-down box to the  

     left of the Input Line. 

a.  Response: icon image changes to the relative indicator. 

4.  Enter .1 into the X: textbox of the Input Line then  

     press <Enter>. 

a.  Response: the bottommost, right-side vertices move to  

     the right .1 units. 

 

A Brief Note on Moving Elements in 
Absolute Mode 

To move elements to absolute positions, in step 3 do a 

select Absolute transform instead of a Relative transform, 

all the other steps are the same.  Figure depicts the fourth 

row of back vertices moved to Z=0, to create a back 

wedge. 

 

Figure 16.  The Fourth Row of Back Vertices Moved 
Absolute to Z=0, to Create a Back Wedge 
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Merge Operation—Relative & a Note on 
Absolute Movement 
 

The merge operation takes two or more vertices either that 

are close to one another, or that overlap one another, and 

makes them into a single vertex.  Merge is useful for 

connecting separate body parts, such as a hand to an arm, 

or a foot to a leg, or a head to a torso.  Note: before 

merging separate models, they must be combined via the 

menu item Mesh > Combine.   

Moreover, when modeling a human figure using the Basic 

Manikin Method in this paper, there are situations where 

you will move and overlap vertices.  Examples include 

creating a back wedge (see Figure 16), or making a box 

into a foot (see Figure 5, Step 2).  By applying the merge 

operation to the overlapped vertices, you remove the 

extraneous points. 

 

 

 

 

Figure 17.  Merge Operation Applied to the Back 
Wedge Vertices 

To merge vertices: 

1.  Drag-select the vertices that overlap, by using the  

     mouse to drag a rectangle that encloses the overlapping  

     vertices. 

a.  Note: It is best to select overlapping vertices in  

     wireframe mode, which can be entered by pressing the     

     <4> key as a shortcut, or via the workspace menu item  

     Shading > Wireframe. 

b.  Response: The overlapping vertices are highlighted. 

2.  Select the menu item Edit Mesh > Merge. 

a.  Response:  There is no visible response, but any  

     overlapping vertices become a single vertex. 

3.  (The model with the back vertices merged) 

 

 

Mirror Operation 

Modelers use the mirror operation to save time.  

Mirroring is appropriate whenever the object to be 

modeled is largely symmetrical, such as a body or a head.  

To mirror, a modeler creates half the object, and uses the 

mirror operation to create the other half automatically via 

the software. 

 

  

1 2 

 

 

3 4 
 

Figure 18.  An Example of the Mirror Operation 

The steps to mirror an object are:  

1.  (Model half of an object) 

2.  Delete any faces on the other half of the object by first  

     selecting the menu item Select > Face, then drag- 

     selecting the unmodeled half of the object, and finally  

     pressing the <delete> key. 

a.  Response: Half of the object is displayed. 

3.  Mirror the other half of the body by first selecting the  

     menu item Select > Object / Component, selecting the  

     object, then selecting the menu item Edit > Duplicate  

     Special > Options.  When the Duplicate Special  

     Options window opens: (a) select the Instance radio  

     button; (b) type -1 into the first Scale: textbox; and (c)  

     press the Duplicate Special button.   

a.  Explanation: Typing -1 into the very first Scale:  

     textbox, mirrors the object across the X-axis by taking  

     every vertex in the object and making a copy of it  

     except with the X-coordinate negated. 

b.  Response: The other half of the object is automatically  

     created. 

4.  (The result of the mirror operation) 

 

 

 

 

 

 

 

 

 

 


